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The Child Care Professional
The Newsletter of the Child Care Resource & Referral at WKU

The Child Care Professional is published monthly by Training & Technical Assistance Services and the Child Care Resource 
& Referral (CCR&R) at Western Kentucky University.  The CCR&R at WKU serves the Barren River Area Development Dis-
trict of Kentucky which includes Allen, Barren, Butler, Edmonson, Hart, Logan, Metcalf, Monroe, Simpson, and Warren Counties. 
Primary services offered by the CCR&R include: 

Distributing consumer education materials to families seeking child care, 
Providing child care referrals to parents;
Offering training to early childhood providers and parents;
Helping potential child care providers establish programs, 
Providing training hours leading to the Commonwealth Child Care Credential and the Child 
Development Associate (CDA), and
Advocating for affordable, accessible, high quality services for children and families.

The professionals and staff of the CCR&R at WKU are ready to provide assistance in a number of areas.  Our staff includes:  

		  Dr. Connie Jo Smith, CCR&R Director			   Sherri Meyer, CR&R Early Childhood Coordinator
		  Jill Norris, CCR&R Coordinator				    Dr. Amy S Hooten, CCR&R Training Specialist
		  Heather Alms, CCR&R Provider Assistant & Office Coordinator 

Share the Knowledge.    Articles and stories from this newsletter may be photocopied or reprinted without written per-
mission from the CCR&R at WKU.  Reprints should, however, credit the magazine as follows: “Reprinted from The Child Care 
Professional, (date of issue), with permission from the Child Care Resource & Referral at WKU.”

Keep in Touch.    If you are not currently receiving the newsletter at your own center or agency, please contact our office by 
mail, phone or e-mail and we will add your name to our mailing list.  If you, your agency or center are moving, please let us know your 
new address; we’ll update our mailing list, and you won’t miss an issue of The Child Care Professional.  (If you no longer wish 
to receive this newsletter, please contact our office by phone or e-mail and we will remove you from our mailing list.)

Child Care Resource & Referral at Western Kentucky University
1906 College Heights Blvd. #11098, Bowling Green, Kentucky 42101-1098

Phone Us at (270) 745-2216 or (800) 621-5908  -  Fax Us at (270) 745-7089
E-Mail Us at ccrr.expert@wku.edu  •  Or Visit Our Website at www.wku.edu/ccrr-wku/

Hours of Operation: 8:00  a.m. - 4:30 p.m., Monday through Friday

Subscription Information.  Any program or person interested in receiving our newsletter may subscribe for $36 per 
year.  The monthly newsletter provides a variety of articles, news, and information for early care and education programs, includ-
ing child care, family day care, preschool, and Head Start.  Caregivers, teachers, administrators, and parents can all benefit from 
the newsletter.  Single complimentary annual subscriptions of The Child Care Professional are provided to licensed child care 
centers, certified home providers, and special friends in the Barren River Area Development District (BRADD) of Kentucky.  Addi-
tional subscriptions may also be purchased by these readers for the same rate of $36 per year.  All registered providers in the BRADD 
qualify for the discounted rate of $26 per year for each additional subscription.

The newsletter is available in both printed and electronic versions.  Print copies of The Child Care Professional are mailed at 
the end of each month; electronic copies are e-mailed directly to subscribers in a Portable Document File (PDF) which can be printed 
or viewed on your computer using Adobe Acrobat Reader (free software downloadable from www.adobe.com).  Readers may select 
the format they prefer when subscribing.  To receive an subscription form or to learn more, please contact our office by phone (800-
621-5908 or 270-745-2216), by fax (270-745-7089), or by e-mail (heather.alms@wku.edu). 

Funded in part by the Kentucky Cabinet for Health & Family Services through the University of Kentucky Research Foundation. 
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2008 Kentucky Licensing Regulations:
Playgrounds

Dr. Amy Hooten, CCR&R Training Specialist

	 Kentucky has implemented new regulations, effec-
tive July 1, 2008.  It was expected that programs be in 
full compliance of these new regulations no later than 
October 1, 2008.    With the revised regulations, some 
changes in regulation and interpretive guidelines were 
made in the area of Playgrounds.   

What do the regulations say about 
Playgrounds for Certified Family Child Care 
Providers? 

	 The regulations regarding playgrounds for Certi-
fied providers are found in 922 KAR 2:100, Section 
10, numbers 14 – 19.  These regulations state the 
following:  

The outdoor play area is to be free from unavoid-
able danger or risk
Each child must be under direct supervision of the 
provider
Stationary play equipment in the outdoors must be 
securely anchored, developmentally and appropri-
ate for the age group using it, and safe. 

What do the regulations say about 
Playgrounds for Licensed Providers (Type I 
and Type II)?

	 Regulations for Type I and Type II licensed provid-
ers are found in 922 KAR 2:120 Health and Safety, 
section 4, numbers 18-26.  These regulations state the 
following:   

The outdoor play area is to be fenced to keep 
children safe, unless the program is located on the 
premises of a public or state-accredited school and 
is used for after school child care.  The fence must 
be constructed of safe materials, in good condition, 
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and be stable. 
The outdoor play area must have 60 square feet 
per child (this is separate from the indoor require-
ment of 35 square feet per child)
The outdoor play area must be free from litter, 
glass, rubbish, and flammable materials.  
The outdoor play area must be safe from hazards, 
well-drained, well-maintained, and in good repair.
The outdoor play area must be visible to staff at all 
times.
The playground must include a protective surface 
under equipment that is used for climbing, swing-
ing, and sliding and must have appropriate fall 
zones. 
Climbing equipment and other large pieces of 
equipment must be securely anchored.
Crawl spaces must be short and wide enough to 
allow an adult access as well as a child.
Sandboxes must be kept cleaned, must be designed 
to allow drainage, checked for vermin and other 
debris before use, and must be covered when not 
used.
Licensed providers may not use portable wading 
pools, should not have natural bodies of water 
within the play area, and may not use unfiltered, 
non-disinfected containers.
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What exactly does this mean for all providers?

	 All providers, certified and licensed, need to be well-
versed in the requirements for playgrounds.  There is a 
resource referenced within the Interpretive Guidelines 
that will be used when programs are being monitored.  
This resource, Public Playground Safety Handbook, 
published by the Consumer Product Safety Commis-
sion (CPSC), is available to you free of charge by the 
CPSC.  You can access this resource by visiting their 
website at www.cpsc.gov.  Go to the “Press Room” and 
look at their publication lists.  You will find an index 
where you can choose “Playground Safety” and at the 
bottom of the page, you will find the document under 
technical documents and handbooks.  You can also 
contact CPSC by phone at 
800-638-2772 to request 
the publication.

	 It is also crucial that 
all providers ensure that 
they have appropriate 
surfacing under their play 
equipment and that the 
fall zones be accurate and 
well-maintained.  Any 
piece of equipment de-
signed for a child to climb, 
such as a climber, slide, 
swing, balance beam, etc. 
requires a protective surfacing under and around it so 
that if the child falls, the surface can help break the fall 
in an effort to prevent major injuries from occurring.  

	 Equipment like swings, climbers, and slides have 
very specific fall zone requirements that must be ad-
hered to in order to prevent injury from occurring on 
playgrounds.  The Public Playground Safety Handbook 
referenced above outlines the approved kinds of surfac-
ing materials, along with the specific measurements and 
information for fall zones. 

Is there anything else I need to know about 
the revised regulations and playgrounds?  

	 The revised regulations tell licensed providers that 
if they do not have an outdoor play area, then they must 

have access to an area indoors that can be used for play.  
This indoor area must be at least 60 square feet per 
child, be well-ventilated and heated, and include equip-
ment that can be used for gross motor play.   Just as you 
include protective surfacing outdoors, you must include a 
protective surface for equipment used for climbing.  This 
type of surface would include a protective mat at least 
two inches (2”) thick.  

Are there other outdoor issues that I need to 
know about?  

	 The revised regulations address the use of swimming 
pools and trampolines, specifically 922 KAR 2:100, 
numbers 17-19 for Certified Providers and 922 KAR 

2:120, number 25 for Li-
censed providers.  Informa-
tion regarding the type of 
pool, height of walls, etc. is 
all found in the regulations, 
while additional require-
ments are also provided in 
the Interpretive Guidelines 
for all providers regarding 
the use of pools in early 
care and education.  

	 The regulations for Cer-
tified providers specifically 
state that trampolines are 

not to be used by children in care, while the Interpretive 
Guidelines provide additional information.  

Who can help us understand how to meet 
these new regulations?

	 Staff members from of the Child Care Resource 
& Referral have been trained in playground safety and 
are available to visit your program free of charge to offer  
assistance and information.  This technical assistance is 
not only available in the area of playground safety, but 
CCR&R staff are also available to provide additional 
assistance with understanding all of the new regulations 
as well as developmentally appropriate practices within 
the field of early care and education.  Feel free to con-
tact the CCR&R at ccrr.expert@wku.edu or by phone 
at 1-800-621-5908. 
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CCR&R Professional 
Development Training

March 2009
Registration Portfolio
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Attending Weekday Training?  We Provide the Parking Pass!
	 Weekday parking on the WKU campus can be difficult.  That’s why the CCR&R provides free temporary WKU 
Visitor’s Parking Passes for those pre-registering to attend CCR&R training on a weekday (Monday-Friday).  Stick-
ers can be picked up at Registration and should be placed on the driver’s side dashboard of your car.  Passes are valid 
only for the dates indicated on the pass.  With a Visitor’s Pass, you may park in all Non-Premium lots, including 
non-premium Faculty/Staff, Housing, Student, and Commuter Lots.  You cannot park in Premium (i.e., gated) Lots, 
Handicapped Parking Slots, or Loading Zone slots, or in fire lanes or other parking-prohibited areas.  (As always, 
parking on campus is not regulated after 5:00 and on weekends, so passes are not required for attending evening train-
ing or training on Saturdays.) 

	 Although the CCR&R will have parking permits available for you at registration, you may still pick up 
on your own if you wish.  Visitor parking permits are available at the WKU Transportation Office located at 
578 Campbell Lave or at the Kentucky Museum on Kentucky Street.

CCR&R Professional Development Training
March 2009 Registration Portfolio

The Child Care Resource & Referral at WKU is the leading provider of quality, af-
fordable training in the 10 counties of the Barren River Area Development District.  
The professional staff and consultants of the CCR&R provide Professional Develop-

ment Training each month on a variety of topics, suitable for both new and veteran child 
care and family child care staff and administrators.  Events are conveniently scheduled 

in the evening or on Saturdays and participants qualify for Child Care Training Credits.

This special removable section of The CCR&R Professional contains registration 
forms for upcoming training events for the months of March 2009.  Simply detach the 
portfolio pages from the rest of the newsletter and copy the registration form or forms 
you need.  Then pass the Registration Portfolio on to your co-workers or col-
leagues so that they may copy the forms to register for the training in which they are 

interested.  Please complete and return your registration form(s) with payment by the 
date specified on each form.  You may also register on-line for all CCR&R training at 
www.wku.edu/ccrr-wku.  For additional details on scheduled events, please contact 

the CCR&R at (270) 745-2216 or (800) 621-5908.  

The CCR&R reserves the right to cancel an event if enrollment criteria are not met or 
when conditions beyond our control prevail.  In the event of cancellation,the liability of the 

CCR&R is limited to the refund of registration fees only.
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Doors will open and participant check-in will begin 1:00 p.m.
Copy and share this form as necessary; print clearly and submit one form per person.

Registration Fee is $30 per participant.
Register on-line at www.wku.edu/ccrr-wku  OR  return form with payment by March 2, 2009. 

Registrations will be accepted after March 2, 2009 only if space is available, and an additional $5 
processing fee will be added to the Registration Fee.  There will be no on-site registrations!

 

Please register on-line at www.wku.edu/ccrr-wku OR return completed registration form with payment to:

Child Care Resource & Referral
Western Kentucky University, 1906 College Heights Blvd. #11098

Bowling Green, KY  42101-1098

ACCESSIBILITY NEEDS: Do you have a disability that requires special materials or services?  Please explain:____________________
CANCELLATIONS:  To avoid obligation for payment of fees or to obtain a refund, all cancellations must be received in writing five working 
days prior to the event.

Introduction to Resources in Kentucky
9:30-11:30 p.m., Tuesday, March 10, 2009

Room 104, Jones-Jaggers Hall, University Boulevard, WKU, Bowling Green, Ky

For training to count toward the required training hours for child care providers, the state of Kentucky requires 
that trainers have a Kentucky Trainer’s Credential.  To earn the Kentucky Trainer’s Credential, a training profes-
sional must meet certain requirements and participate in two required training sessions.  If you are an Early 
Care and Education professional who is working on or interested in obtaining a Kentucky Trainer’s Credential, 
you will want to first participate in Introduction to Resources in Kentucky.  This is one of two sessions required 
to submit an application for a Kentucky Trainer’s Credential.  Training is limited to 25 participants per session.  
Please note that training hours are not awarded for this training.

Name: ____________________________________  Position:__________________________________
Age Group(s) Served: __________________________  Program Name:___________________________________
Address: _____________________________________________________________________________
City: _________________________________  County: _______________  State: ____  Zip Code: ____________
Phone Number : _____________  E-Mail Address for Confirmation (if available): ______________________________
ECE-TRIS ID Info:     Birth Date: __ __ / __ __ / __ __ __ __ (Day/Mo/Yr)     Last 4 Digits of SSN: __ __ __ __   
	Check Enclosed	 	  Purchase Order #_______________ Enclosed
	Please bill my Credit Card (Visa, Mastercard, Discover):	 __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __
	 Card Expiration Date: __ __ / __ __ 	 Signature: ___________________________________________

CCR&R Professional Development Training
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CCR&R Professional Development Training
Saturday, March 21, 2009

WKU Glasgow Campus, 500 Hilltopper Way, Glasgow, Kentucky

Doors will open and participant check-in will begin at 8:30 a.m. 
Copy and share this form as necessary; print clearly and submit one form per person. 

Registration Fees are $20 per participant for the 3-hour Morning Session and
$15 per participant for the 2-hour Afternoon Session.  ($35 for a full day of training)

Register on-line at www.wku.edu/ccrr-wku OR return form with payment by March 9, 2009.

Registrations will be accepted after March 9, 2009 only if space is available, and an additional $5 
processing fee will be added to the Registration Fee.  There will be no on-site registrations!

To receive CEU Credits, please check here ___ and include an additional $15 fee.

Please register on-line at www.wku.edu/ccrr-wku OR return completed registration form with payment to:

Child Care Resource & Referral, Western Kentucky University
1906 College Heights Blvd. #11098, Bowling Green, KY  42101-1098

ACCESSIBILITY NEEDS: Do you have a disability that requires special materials or services?  Please explain:_______________________________
CANCELLATIONS:  To avoid obligation for payment of fees or to obtain a refund, all cancellations must be received in writing five working days prior to 
the event.

Morning Session:  9:00 a.m.-Noon
ReCharge!  ReCharge is a program developed for grades 3-6 to be used in after-school settings.  Energy-In (the calories we consumer, 
Energy-Out (the calories we burn), teamwork, and goal-setting are all concepts taught through various activities that engage students 
in active play.  During the training, participants will learn how to implement the program in their facility. Presenter: Miranda Hunt, 
Professional Family & Development Supervisor, PACS-NOW.  Target Audience: School-Age.  CDA Subject Area: 1.  Core Content: 
Health, Safety & Nutrition.  Training Level: 2.
Professional Development Plans: What Are They and How DO We Do Them.  This session is designed to assist pro-
viders with understanding the Professional Development plans that are required by the state child care regulations.  Participants will 
examine a sample plan and practice writing a plan.  (This is a repeat of the session offered in September 2008.)  Presenter: Dr. Amy 
Hooten, CCR&R Training Specialist.  Target Audience: General.  CDA Subject Area: 6.   Core Content: Professional Development, 
Professionalism.  Training Level: 2.

Afternoon Session:  1:00-3:00 p.m.
Planning Your Day: The What, Why and How of Appropriate Daily Schedules.  Participants in this session will examine 
the components of appropriate daily schedules and will look at the child care licensing requirements for daily schedule for all age groups. 
Presenter:  Dr. Amy S. Hood Hooten, CCR&R Training Specialist.  Target Audience: General.  CDA Subject Area: 5.  Core Content: 
Learning Environments & Curriculum.  Training Level: 3.
Games School-Agers Play.  This sessin will explore the benefits of playing games with school-agers ad games that can be played 
in school age programs.  Presenter:  Jill Norris, CCR&R Coordiantor.  Target Audience: School Age.  CDA Subject Area: 1.  Core 
Content: Learning Environments & Curriculum.  Training Level: 2.









Name: _______________________________________________  Position:______________________________________________
Age Group(s) Served: ______________________________  Program Name:________________________________________________
Address: ____________________________________________________________________________________________
City: _______________________________________________  County: _______________  State: ______  Zip Code: ____________
Phone Number : _____________  E-Mail Address for Confirmation (if available): ______________________________
ECE-TRIS ID Info:     Birth Date: __ __ / __ __ / __ __ __ __ (Day/Mo/Yr)     Last 4 Digits of SSN: __ __ __ __   
	Check Enclosed	 	  Purchase Order #_______________ Enclosed
	Please bill my Credit Card (Visa, Mastercard, Discover):	 __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __
	 Card Expiration Date: __ __ / __ __ 	 Signature: ___________________________________________
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CCR&R Professional Development Training
Orientation Training for Early Care & Education Professionals

Saturday, March 21, 2009
WKU Glasgow Campus, 500 Hilltopper Way, Glasgow, Kentucky

Doors will open and participant check-in will begin at 8:30 a.m.
Copy and share this form as necessary; print clearly and submit one form per person.

Registration Fee is $40 per participant.
Register on-line at www.wku.edu/ccrr-wku OR return form with payment by March 9, 2009.

Registrations will be accepted after March 9, 2009 only if space is available, and an additional $5 
processing fee will be added to the Registration Fee.  There will be no on-site registrations!

To receive CEU Credits, please check here ___ and include an additional $15 fee.

Please register on-line at www.wku.edu/ccrr-wku OR return completed registration form with payment to:

Child Care Resource & Referral, Western Kentucky University
1906 College Heights Blvd. #11098, Bowling Green, KY  42101-1098

ACCESSIBILITY NEEDS: Do you have a disability that requires special materials or services?  Please explain:____________________
CANCELLATIONS:  To avoid obligation for payment of fees or to obtain a refund, all cancellations must be received in writing five working 
days prior to the event.

Morning Session:  9:00 a.m. - Noon
Basic Health, Safety, and Sanitation and Recognizing and Reporting Child Abuse.  This is 
the first half in a mandatory session of six-hour training that all child care employees must attend during the 
first 90 days of employment. Presenter:  Jill Norris, CCR&R Coordinator.  Target Audience: New Employees.  
CDA Subject Area:  1.  Core Content:  Health, Safety & Nutrition.  Training Level:  1.  This session also 
functions as the Registered Providers Orientation.

Afternoon Session:  1:00-4:00 p.m.
Recommended Practices.  This is the second half of the mandatory session of six-hour training that all 
child care employees must attend during the first 90 days of employment.  Presenter:  Sherri Meyer, CCR&R 
Parent & Community Coordinator.  Target Audience: New Employees.  CDA Subject Area:  1.  Core Content:  
Learning Environments & Curriculum. Training Level:  1.  





Name: ____________________________________  Position:__________________________________
Age Group(s) Served: __________________________  Program Name:___________________________________
Address: _____________________________________________________________________________
City: _________________________________  County: _______________  State: ____  Zip Code: ____________
Phone Number : _____________  E-Mail Address for Confirmation (if available): ______________________________
ECE-TRIS ID Info:     Birth Date: __ __ / __ __ / __ __ __ __ (Day/Mo/Yr)     Last 4 Digits of SSN: __ __ __ __   
	Check Enclosed	 	  Purchase Order #_______________ Enclosed
	Please bill my Credit Card (Visa, Mastercard, Discover):	 __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __
	 Card Expiration Date: __ __ / __ __ 	 Signature: ___________________________________________
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Child Care Resource & Referral Telephone Conference

The Child Care Resource & Referral at WKU is pleased to announce a special telephone conference 
which allows you to participate in training by telephone from any location - from your home, office, or another location.  No 
travel time, no per diem expenses, no hassle, and low cost!  After you register and shortly before the telephone event, you will be 
mailed the session handouts, directions for calling in, and the central phone number you should call to participate.  After the call, 
the CCR&R phone service provider will provide the names of those participating in the call and the length of their participation.  
Certificates for one hour of training will be mailed to all registered participants whose phone lines remain active for the full length of 
the telephone conference call.  

Please copy and share this form as necessary.  Please print clearly and submit one form with payment per person.

Registration Fee is $10 Per Participant Per session
Register on-line at www.wku.edu/ccrr-wku OR return form with payment by March 14, 2009. 

Registrations will be accepted after March 14, 2009 only if space is available, and an additional $5 
processing fee will be added to the Registration Fee.

Please register on-line at www.wku.edu/ccrr-wku OR return registration form with payment to:

Child Care Resource & Referral
Western Kentucky University, 1906 College Heights Blvd. #11098

Bowling Green, KY  42101-1098

CANCELLATION: To avoid obligation for payment of fees or to obtain a refund, all cancellations must be received in writing five working 
days prior to the event.

Culture as Part of the Daily Activity
6:00 - 7 :00 p.m., Tuesday, March 24, 2009

This session will look at the new requirement for addressing culture in the program of activities and explore ways 
of addressing culture in daily activities.  Presenter:  Jill Norris, CCR&R Coordinator.  Target Audience: General.  
CDA Subject Area: 1.   Core Content: Learning Environments & Curriculum.  Training Level: 2.

Name: ____________________________________________  Position:_____________________________________________
Age Group(s) Served: __________________________  Program Name:_______________________________________________
Address: _______________________________________________________________________________________________
City: __________________________________________  County: _______________  State: ____  Zip Code: ____________
Phone Number : _____________  E-Mail Address for Confirmation (if available): ____________________________________
ECE-TRIS ID Info:     Birth Date: __ __ / __ __ / __ __ __ __ (Day/Mo/Yr)     Last 4 Digits of SSN: __ __ __ __   
	Check Enclosed	 	  Purchase Order #_______________ Enclosed
	Please bill my Credit Card (Visa, Mastercard, Discover):	 __ __ __ __ __ __ __ __ __ __ __ __ __ __ __ __
	 Card Expiration Date: __ __ / __ __ 	 Signature: ___________________________________________
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Want to Be Published?  Or Announce An Event? 
       If you are an administrator, coordinator, teacher, or caregiver, we encourage you to submit articles to be considered 
for publication in The Child Care Professional. You can share your experiences in early care and education, tell 
us about activities that work well with children, share ways you communicate and involve families, or discuss ideas for 
working with colleagues or community partners. Do you have a scholar story to tell about going back to school?  Have 
a story about working on  STARs for your facility?  Want to tell us about your experiences starting your child care 
program?  We welcome your submissions. 

      All non-profit agencies are also welcome to submit announcements for consideration of 
publication in the CCR&R newsletter. Describe your services, let us know about an upcom-
ing event, or describe a specialized service your agency provides. We do not guarantee accep-
tance or the exact date of publication, but we want you - as our partners in early childhood - to 
freely contribute to YOUR newsletter.  We will make every effort to include your articles and 
announcements in The Child Care Professional on a timely basis.  

	 All articles, submissions, and announcements should be limited to 400 words or less, and must be typed and sent 
electronically. (Sorry, submissions cannot be returned.) You may e-mail your submissions to connie.smith@wku.edu, or 
mail them on disk to: 

Child Care Resource & Referral at WKU
1906 College Heights Blvd. #11098, Bowling Green, Kentucky 42101-1098.

Coming Next Month...
In the month of April, the CCR&R at WKU will be presenting sessions designed for Infant/Toddler 
Teachers. We’ll also be scheduling a telephone training to provide information on Best Practices.
  
On Thursday, April 23rd, the CCR&R will present the Orientation Training for Early Care & 
Education Professionals.  This is the six-hour training that all child care employees must attend dur-
ing the first 90 days of their employment.

Lost Training Certificate?
	 If you are a frequent participant in CCR&R train-
ing, you know how hard it can be to keep up with all of 
your training certificates.  If you’ve lost the certificate 
from any CCR&R professional development training 
that you attended, the CCR&R  will be glad to re-issue 
the training certificate.  Duplicate training certificates 
are $5 each and can be ordered by contacting Heather 
Alms.  You can call Heather at 270-745-2216 or 800-
621-5908 or e-mail your request or questions to her at 
heather.alms@wku.edu.

Training Cancellations
	  Whenever weather or road conditions are question-
able, please call 800-621-5908 or 270-745-2216 before 
traveling to CCR&R training.  If the CCR&R cancels 
scheduled training due to inclement weather and cancel-
lation, notices will be posted on the CCR&R phone 
system.  In the event of cancellation, registration pre-pay-
ments will be refunded or applied to a later session.  As 
always, whether training is cancelled or not, we encour-
age you to use your own best judgment when traveling in 
wintry weather!
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February’s Child Care Provider Appreciation Day Question:

What are the 12 types of creative activities that Kentucky child care regulations 
require licensed providers to include in the daily planned program of activities?

Your Answer:  ____________________________________________________________________________

_______________________________________________________________________________________

_______________________________________________________________________________________

Your Name:  _____________________________________________________________________________

Your Daytime Telephone Number: _____________________________________________________________

The Child Care Program You Work For: _________________________________________________________

February’s prize is a Lakeshore Heavy-Duty Sand Tools Set.

Limit one entry per person, but you may copy the entry form and share with your col-
leagues.  To be eligible for the February drawing, your correct entry must be received no later 

than February 27, 2009.  Mail your completed entry to: 

Jill Norris, Coordinator, CCR&R at WKU
1906 College Heights Blvd. #11098, Bowling Green, KY  42101-1098

Fax Number:  270-745-7089

Eligibility:  Individuals must be employed by a licensed or certified child care program that operates in one of the 
following counties: Allen, Barren, Butler, Edmonson, Hart, Logan, Metcalfe, Monroe, Simpson, or Warren.  Only 
one entry per person will be accepted.  All entries must be received by the deadline indicated above.  The winner is 
responsible for picking up the prize at the CCR&R office, located at Jones-Jaggers Hall on the campus of Western 

Kentucky University in Bowling Green.

Celebrate Child Care Provider Appreciation Day:

Enter for a Chance to Win!
	 Child Care Provider Appreciation Day is just around the corner!  Since 1996, Child Care Provider 
Appreciation Day (PAD) has been celebrated on the Friday before Mother’s Day as a way to recognize child care 
providers.  For the coming year, May 8, 2009 has been designated as the day to celebrate Child Care Providers.

	 As part of this year’s celebration, the Child Care Resource & Referral (CCR&R) at WKU is conducting a 
monthly contest for licensed and certified child care providers in the Barren River Area Development District.  By 
entering this contest, you have the opportunity to both test your knowledge and earn a chance to win a prize!  

	 The February through May editions of The Child Care Professional will contain a child care question.  To 
enter the contest, you will need to submit a correct answer to the question, along with some demographic information, 
to the CCR&R at WKU.  All entries with the correct answer will be entered into a random drawing to select the 
winner.  The winner will be notified by telephone and their name will be announced in the following month’s edition of 
The Child Care Professional.  February’s question and prize are listed below.  Good Luck!
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	 If you are still using handwritten records, you are not 
alone.  Using a computer can often be an overwhelming 
and challenging experience.  For many of us, it is dif-
ficult to trust an electronic device, especially if you are 
unsure of its capabilities.  However, using a computer 
has its benefits.  You can work faster, keep better and 
more detailed records, and if you back-up your files, you 
have less chance of losing information than with hand-
written records.  

	 If you have Microsoft Office, then your computer 
has Excel.  Microsoft Excel is a a popular “spreadsheet” 
software program that allows to you easily keep track 
of records.  It comes com-
plete with the ability to add 
formulas that will automati-
cally do calculations for you. 
It can be used to help you 
monitor your spending, track 
payments for services, create 
charts, and much more.   

	 Understanding the basics 
of Excel is your first step to 
creating spreadsheets that 
will change how your pro-
gram operates. Here is some 
introductory information and 
we have also included a helpful web link at the end of 
this article.

What Makes Up A Spreadsheet?

Cell – Where a column and row intersect, labeled 
A1, A2, B4, B21, etc., where letters represent the 
column and numbers represent the row
Row – Numbered, horizontal series of cells
Column – Alphabetized, vertical series of cells
Range –A group of cells specified by an upper left 
cell address and a lower right cell address like this: 
(for example, A1:Z25 would be from cell A1 to 
Cell Z25).
Worksheet or Sheet – A tab in the workbook; 

$

$
$
$

$

may be multiple pages.
Workbook – An entire document or file that may 
include many worksheets.

Data Entry

	 To enter information into a cell, just click on the cell 
and type in the character(s). Use the tab key to move 
across and use the enter key to move down.  Or, use the 
arrow keys to move from cell to cell.

	 Please note that when you are entering information 
into a cell, you are not limited to the space of the cell dis-

played on the screen.  Text 
may run across several cells, 
but may not print correctly 
unless you make the cell 
wider, or use the Format 
menu options to wrap text, 
or shrink to fit.  To make the 
cell wider, click and drag 
the lines next to the letters 
or numbers.  Cell contents 
may run across an unlimited 
number of cells, but unless 
you wrap the text, they will 
not move down.  If you use 
the enter key to force a line 

break, you move into a new cell.  

Format Features

Under the Format menu, choose Cells.  Change 
the format of numbers, the alignment including angle 
of text, merging and wrapping text, and cell borders 
and colors.  These features apply to any selected 
cell(s).

Under the Format menu, choose Rows.  Hide or 
Unhide rows.

Under the Format menu, choose Columns.  Hide 
or Unhide columns, and also set column width.

$

$

$

$

Microsoft Excel for Recordkeeping
Heather Alms, Office Coordinator and Provider Assistant
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Under the Format menu, you may choose Auto-
Format.  Before choosing AutoFormat, you should 
select the area to format first!  Otherwise, it will try 
to format the entire possible spreadsheet that will 
overrun the computer’s memory.

	 On the Toolbar, there is a button for Merge and 
Center (immediately right of the alignment buttons).  
This is useful for page headings or titles.  Select the cell 
containing title text, and the other cells you wish the title 
to span.  Then, click the button.  This “merges” all the 
selected cells and centers the text across them in one step.

	 The drawing toolbar common to all Microsoft 
Office products is also available.  Drawing objects such 
as clipart, shapes, arrows and 3-D shapes, WordArt and 
text boxes may be placed anywhere on a spreadsheet.  
If you don’t see the drawing toolbar on the bottom of 
the screen, choose the View menu, then Toolbars, then 
select Drawing.

Quick Tips

Select cells or data and use Copy, Cut, Paste, and 
Format features as in any Windows program.

To drag and drop, position the cursor on the edge of 
a selected area and drag.

The Fill Handle is a small box in the lower right cor-
ner of any selected cell area.  Click on this “handle” 
and drag to fill cells with repeated information, or to 
continue a sequence of information such as dates.

Double-click the separator between column letters 

$

1.

2.

3.

4.

to automatically adjust the column width to show all 
data.  Drag the separator to size the column manu-
ally.

Use Ctrl + click to select non-adjacent cells for 
charts and formatting.

Sort

	 To sort a single column alphabetically or numerically 
in increasing or decreasing order:

Click on the column letter to select the entire column

Click the “A-Z” button on the toolbar.  One A-Z 
button has an arrow pointing up, and one has an 
arrow pointing down.  

Pleas note that if you do this sort, the row items will 
no longer be together.

To keep cells on a row all together, but still put the 
rows in increasing or decreasing order, do the follow-
ing:  

Select all of the columns.

Click the Data menu, then Sort.

In the dialog box, select the column heading by 
which you wish to sort.

Formulas

	 Formulas in Excel can either be simple or extremely 
complex.  The simplest way to create basic formulas is 
the AutoSum feature found in your top toolbar.  It has 
a symbol that looks like a sideways M.  If you want to 
Add a group of numbers, simply enter them into the 
cells.  Each cell should get its own number.  Then, high-
light the cells you want to sum, and click the AutoSum 
button.  The total will be placed in the next cell.  If you 
click on that cell, you will be able to see the formula in 
the function bar at the top under the toolbar.  It should 
look something like this: =SUM(D13:D17).  Formulas 
may also be entered manually.  

Print Options

	 Print Preview, under the File menu, is extremely 
important in Excel.  It is the only way you will know 
what the printout looks like.  The Excel worksheet does 

5.
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$

$

$

$

$

$
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not always print the same way it displays.  After you 
once look at Print Preview and then return to normal 
view, you will see a dotted line indicating where page 
breaks are located.

	 Many spreadsheets lend themselves to a landscape 
paper orientation – wider than they are tall.  Also, in 
some cases, you may want to include the “gridlines” in 
the printed copy of the worksheet.  Under the File menu, 
choose Page Setup.  In the dialog box, paper orientation 
is under the Page tab.  Gridlines may be added under the 
Sheet tab.  You can also set margins and add a header 
and footer to your printout in the Page Setup dialog box. 

Want to Know More?

	 Microsoft Excel can handle a wide range of needs 
for record keeping.  The program and Microsoft’s 
website offer free templates that you can modify to 

meet your needs.  If you would like to create your own 
spreadsheets or would like to learn more on the abilities 
of Excel, the local library or bookstore offer books for 
beginners as well as advanced users.  Or you may con-
sider taking a class; classes may be offered on-line or in 
a classroom setting at your local university, community 
or technical college, career center, or Community Ac-
tion location. 

	 Microsoft has free online training, tutorials, demos, 
and templates. Check them out at http://office.microsoft.
com/en-us/training/HA102189871033.aspx. 

Other Spreadsheets

	 Microsoft Excel is popular but only one of the 
spreadsheet software packages available. Another option 
is to use Calc, which is an open source (i.e, it is free) 
from OpenOffice.org. It is similar to Microsoft Excel.

Special Congratulations 
	 The CCR&R would like to congratulate the following individuals for their professional accomplishment of 
completing the required 120 clock hours of training toward a Child Development Associate (CDA) Credential.  

Brenda Atkins, Warren Co.
Kristi Bartley, Monroe Co.
Beverly Bonilla, Butler Co.

Susanne Bowling, Warren Co.

Stephanie Browning, Warren Co.
Joyce Cornwell, Allen Co.
Bivian Driver, Hart Co.

Opal Faye Cornwell, Allen Co.
Paula Elsener, Warren Co.

	 Most of these individuals began classes in January 
2008, earning the Commonwealth Child Care Cre-
dential along the way, and completing the 120 hours in 
November 2008.   In addition to the required training 
hours, individuals working on a CDA must also com-
plete a resource portfolio, competency goal statements, 
and are awaiting their final step - the assessment process 
which includes a visit from a Council representative from 
the Council for Professional Development in Washing-
ton, D.C.  Upon completion of the assessment process, 
the award of the CDA credential will be determined.  

	 We recently gathered at a local restaurant with our families and friends and celebrated the efforts of each 
person and the conclusion of the training.  A big CONGRATULATIONS to these individuals for their pro-
fessional development accomplishment! 

Betty Heldt, Warren Co.
Cynthia Mathis, Warren Co.
Miguel Ortega, Warren Co.
Felicia Payne, Simpson Co.
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